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Abstract: In the process of social development and progress, people pay more 
attention to the knowledge and cultural heritage contained in intangible cultural 
heritage. With the continuous development of digital technology, the protection and 
inheritance of intangible cultural heritage have begun to adopt new technical means. 
This study focuses on the national intangible cultural heritage of Ningbo Gold 
Lacquerware, exploring its image extraction and the analysis of its implied symbolism. 
The extracted images of Ningbo Gold Lacquerware are digitized for 3D garment 
design, demonstrating the unique charm and innovative application of Ningbo Gold 
Lacquerware in fashion through practical cases. This study aims to provide new ideas 
and methods for integrating traditional patterns with digital clothing design, while also 
promoting the diversified inheritance and development of intangible cultural heritage. 
Keywords: Ningbo Mud-Gold Color Paint, National Intangible Heritage, Image 
Extraction, Digitization, Clothing Innovative Design. 

1. INTRODUCTION 

Ningbo Gold Lacquerware is one of China's intangible cultural heritages, 
renowned for its unique craftsmanship and rich imagery (patterns) 
symbolism. The Ningbo Gold Lacquerware technique is primarily popular 
in the “The Ten-mile Red Dowry” marriage culture of Ningshao Plain of 
Zhejiang Province, China. "The Ten-mile Red Dowry" is a traditional 
wedding custom in the Ningshao Plain that originated in the Southern Song 
Dynasty and flourished during the Ming and Qing Dynasties. This custom 
depicts the lively scenes of a wealthy family during weddings, with the 
grand procession of the bride and her dowry stretching for dozens of miles 
in a festive display of red, which is spectacular and is referred to as " The 
Ten-mile Red Dowry." Among the many items in this grand procession, 
one category of colorful folk traditional crafts is indispensable: the "gold 
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lacquerware." This craft is a type of decorative technique on lacquerware 
that combines clay, gold, and colorful lacquer craftsmanship. Since it is 
most prevalent in Ningbo, Zhejiang Province, it is also known as "Ningbo 
Mud-Gold Color Paint. 

2. THE HISTORY OF NINGBO MUD-GOLD COLOR PAINT  

The history of “Ningbo Mud-Gold Color Paint” dates back to the 
Hemudu culture period, 7,000 years ago. Archaeologists excavated an inner 
red, outer black lacquer bowl from the Hemudu ruins, which is the earliest 
prototype of gold-painted lacquer wood-style lacquer. This craft reached 
its heyday during the Ming and Qing dynasties. The "Zhejiang Tongzhi" 
records: “During the Xuande years of the Ming dynasty, Ningbo Mud-
Gold Color Paint was famous in China and abroad.” The Ninghai “Ten 
Mile Red Dowry” Museum houses a collection of Ninghai folk lacquer 
furniture from the Qing Dynasty, including a dragon and phoenix red 
board box and large wooden sleeping beds, which showcase the glorious 
history of this lacquer. Ningbo, located in the southeast coastal area and 
one of the earliest commercial ports in China, benefited from trade 
prosperity, creating favorable conditions for the reputation of Ningbo 
Mud-Gold Color Paint (Tao, 2017). 

3. NINGBO MUD-GOLD COLOR PAINT CRAFT 
CHARACTERISTICS AND USES 

Ningbo Mud-Gold Color Paint is crafted with exceptional skill, resulting 
in a brilliant, colorful appearance, particularly striking in the vermilion 
trousseau where it appears glittering. The main raw materials used are raw 
lacquer and gold foil. Lacquerware is primarily made with wooden bases, 
but bamboo slices and bamboo weaving are also used. Depending on the 
pattern's degree of concavity and convexity, production can be classified 
into three categories: flat flower, sunken flower, and floating flower. 
Creating an exquisite lacquer piece typically involves more than 20 
procedures, including tracing, pounding lacquer clay, stacking, applying 
gold, overlaying lacquer, and applying color. In 2011, this lacquerware was 
included in the “Third Batch of National Intangible Cultural Heritage List.” 
Ningbo Mud-Gold Color Paint is one of the most prominent traditional 
techniques in China's arts and crafts, boasting a long history and a variety 
of colorful products. These include furniture, hanging screens, plaques, and 
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small household items such as offering boxes, fruit plates, hand stoves, 
square jewelry boxes, octagonal rice buckets, wine containers, tea buckets, 
and drums. The lacquerware is also used in furniture pieces like beds, 
cabinets, and sedan chairs (Crina Anca Sandu et al., 2011). 

4. THE NINGBO MUD-GOLD COLOR PAINT PATTERN AND 
THE IMPLICATION OF SYMBOLISM 

The traditional craftsmanship of Ningbo Mud-Gold Color Paint relies 
heavily on a variety of decorative patterns, each unique to different periods 
and influenced by the era's specific techniques and styles. The clay gold 
lacquer decorative pattern designs have several distinctive characteristics: 
Firstly, the choice of subject matter is broad, encompassing people, 
animals, plants, flowers, landscapes, pavilions, religious themes, and 
auspicious motifs. For example, peony patterns often represent richness 
and splendor, while the "four gentlemen"—plum, orchid, bamboo, and 
chrysanthemum—symbolize noble character. Additionally, motifs like 
pumpkins, pomegranates, and peaches express wishes for good fortune, 
many children, and longevity. Secondly, the organizational structure of 
these patterns is typically symmetrical and suitable for individual motifs, 
with continuous patterns being less common. The compositions are free, 
clear, elegant, simple, and colorful. The clay and gold lacquer piling effect 
adds a strong sense of three-dimensionality, making the designs appear 
exquisite and gorgeous. Furthermore, the decorative patterns of Ningbo 
Mud-Gold Color Paint have evolved unique styles over different periods.  
The motifs and meanings have profound cultural connotations and 
historical backgrounds. For example, patterns on wedding and daily 
necessities often reflect parents' wishes for their children's future 
happiness. During the Ming and Qing dynasties, auspicious patterns and 
harmonious wordplay were commonly used to symbolize good wishes such 
as joy, prosperity, and fulfillment. There are many homophonic patterns 
such as "Happiness at Your Eyebrows," "Abundance Year After Year," 
and "Everything Goes Well." These patterns are not only decorative but, 
more importantly, they convey symbolic meanings and blessings. In 
modern times, the application of Ningbo Mud-Gold Color Paint has 
expanded beyond traditional trousseau and wooden items. The decorative 
techniques are now used on ceramics, shells, jade, and other materials, 
broadening their scope. The subject matter of the patterns continues to 
innovate, keeping pace with modern aesthetics and meeting contemporary 
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needs. 

5. NINGBO MUD-GOLD COLOR PAINT IMAGE EXTRACTION 
AND ANALYSIS 

5.1 Extraction and Analysis of Patterns on The Embroidered Stool of 
Ningbo Mud-Gold Color Paint Works 

The piece comes from the Ningbo Oriental Art Museum in Ninghai 
County, Ningbo City, Zhejiang Province. The embroidered stool, also 
known as a sitting stool, is a traditional Chinese furniture piece with a highly 
personalized design. It is round with a large belly and smaller top and 
bottom, resembling an ancient drum, which is why it is also called a drum 
pier. The terms "pier" and "stool" are synonymous in this context. The 
embroidered pier has a long history. According to Mr. Shen Congwen in 
his "Study of Ancient Chinese Dress," the waist drum-shaped pier has been 
a special seat for women to warm themselves with incense since the 
Warring States period (Figure 1). The image on the embroidered pier 
depicts the classic Chinese motif “Support the Husband and Educate the 
Children,” an idiom meaning to assist the husband and educate the 
children. This phrase was historically a measure of a woman's moral level 
and a compliment to a virtuous wife. Based on the "mothering skills" 
decorative pattern on the embroidered pier, we used Photoshop's "Cutout" 
tool to extract the image and the "Fill" tool to apply various color schemes. 
Some patterns were further processed with line drawing and dark effects 
to create different visual impacts. These patterns can be applied to various 
design products, such as T-shirts, or in the creation of clothing styles that 
combine traditional and modern elements (Na & Sharudin, 2024). 

 
Figure 1(a): Embroidered Stool and the Image of “Supporting the Husband and 
Educating the Children” Decorated With the “Ningbo Mud-Gold Color Paint” 

Technique. (b) Series of Designs Based on the Image of “Supporting the Husband 
and Educating the Children” 
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5.2 Image Extraction and Analysis of the “Pollen Dipper” on Ningbo Mud-
Gold Color Paint Work 

The "Huafen Aodou" is a tool that ancient women used to make rouge 

and face powder. Some exquisitely crafted Huafen Aodou have gold leaf 

applied to their surfaces and are decorated with piled-up auspicious 

flowers, symbolizing the graceful beauty of women from Jiangnan. 

Particularly, those made for and decorated by high-ranking officials and 

nobility are even more intricate and delicate. This piece (Figure 2-a) was 

created by Mr. Li Guangzhao, the first-generation inheritor of Ningbo 

Mud-Gold Color Paint after the founding of the People's Republic of 

China. It has a wooden base and measures 11 cm in width and 20 cm in 

height. The decorations, made using the Ningbo Mud-Gold Color Paint 

"floating flowers" piling technique, feature various plants. The overall 

shape resembles a goose, symbolizing bravery, loyalty, and good fortune. 

The decorative patterns are based on traditional and classic Chinese plants 

and fruits, arranged in a ring around the vessel. The first image on the lid 

is a persimmon (Figure 2-b), which symbolizes harmony and fulfillment, 

playing on the homophone "persimmon" for "as one wishes." On the side, 

there are orderly "piles" of rose grape (Figure 2-c), representing good luck 

and happiness.  

The lotus flower (Figure 2-d) often describes a kind and beautiful girl, 

pure love, and noble feelings.  It symbolizes a character that remains pure 

and unsullied despite being in a corrupt environment. The image of a peach 

(Figure 2-e), symbolizing longevity and health, reflects aspirations for a 

better life. The "Happiness at Your Eyebrows" image (Figure 2-f): In 

Chinese folklore, magpies often symbolize joyful events. The word "plum" 

sounds like "eyebrow", hence the phrase "Happiness at Your Eyebrows," 

which describes a person beaming with joy. It also signifies the arrival of 

spring and the occurrence of happy events. The pomegranate (Figure 2-g) 

symbolizes many children and good fortune, indicating family prosperity 

and flourishing.  

The twining branch pattern (Figure 2-h-i), known as the "twining flower" 

or "longevity vine," due to its continuous structure, signifies "endless life" 

and implies auspiciousness. The "joy from the sky" image (Figure 2-j) 

depicts a dancing child surrounded by magpies, auspicious clouds, and 

flowers, symbolizing joyful events coming from the sky, a common 

auspicious motif in Chinese folklore. Finally, the goose-like handle and 

butterfly on top (Figure 2-k) symbolize freedom and change in Chinese 

culture, implying sweet love (Chen et al., 2021). 
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Figure 2: "Huafen Aodou" and Image Analysis (a: Huafen Aodou b: Huafen Aodou 

lid and persimmon image c: Precious rose grape image d: Lotus flower image e: 
Peach image f: "Happiness at Your Eyebrows" image g: Pomegranate image h: 

Twining flower image i: Twining flower image j: "Joy from Heaven" image k: Goose-
shaped handle and butterfly image) 

From the above analysis, the images of Ningbo Mud-Gold Color Paint 
are characterized by decorative themes and compositions that express 
auspicious symbols, and the people's visions of wealth, peace, health, and 
constant happiness are the core, revealing strong folklore interests in the 
beautiful blessings. 

6. IMAGE EXTRACTION AND PATTERN DESIGN OF NINGBO 
MUD-GOLD COLOR PAINT 

6.1. Image Extraction Methods and Steps 
For extracting each image from the " Huafen Aodou" as an example, 
Adobe Photoshop drawing software is utilized. Below are the steps to 
follow: 

(1) Open Photoshop software, go to the "File" menu, select "Open," 
then browse and choose the file containing the "Huafen Aodou" images, 
and click on "Open." 

(2) Use the "Magic Wand Tool" or "Quick Selection Tool" for keying. 
Begin by selecting the part of the image from the "Huafen Aodou." If there 
is a high contrast between the background and the object, the Magic Wand 
Tool will be easier to use. For finer control, the Quick Selection tool can 
be employed. 

(3) With the image selected on the "Huafen Aodou", right-click on the 
selection area, and choose "Select Inverse" to select the background. 

(4) Press the "Delete" key to remove the background. This should 
extract the image on the "Huafen Aodou". Repeat this process to extract 
each image from the "Huafen Aodou." If further optimization of the 
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extracted image is required, the "Eraser Tool" or 'lasso' can be used. 
(5) Once extraction is complete, go to the "File" menu, select "Save As," 

choose the desired format and location, and save the extracted image. 
The above steps outline the basic process of extracting the "Huafen 

Aodou" image using Adobe Photoshop. Depending on the specific image 
characteristics, adjustments and optimizations may be necessary. Figure 3 
demonstrates the extraction of images from the "Huafen Aodou" and the 
effect of splicing (He et al., 2021; Wu, 2021). 

 
Figure 3: Image Extraction from "Huafen Aodou". a: Peach image b: Precious lotus 

flower and lotus flower image c: Twining flower image d: Persimmon image e: 
Pomegranate image f: Butterfly image 

6.2. Line Drawing Extraction and Color Filling 
6.2.1 Extracting Image Line Drawing in Adobe Photoshop from "Huafen 
Aodou" 

To extract the line drawing from the "Huafen Aodou" in Adobe 
Photoshop, follow these steps: Select the "Image" menu, then choose 
"Adjustments," and select "Threshold." Adjust the parameters until the 
image displays clear lines. If further optimization of the extracted lines is 
needed, use the "Eraser Tool" or "Lasso Tool" for fine-tuning. 
Alternatively, you can manually draw the image line drawing by creating a 
new layer and using hand-painted board and pencil tools. Pay attention to 
drawing the structure of the image clearly, simplifying some parts of the 
structure if necessary (Figure 4). 

 
Figure 4: Image Line Drawings on "Huafen Aodou" a: Peach image b: Rose grape 

and lotus flower image c: Twining flower image d: Persimmon image e: Pomegranate 
image f: Butterfly image 

6.2.2 Filling Color for the Extracted Image 
The steps for filling color in the extracted "Huafen Aodou" line drawing in 
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Adobe Photoshop are as follows: 
1) Adjust the line drawing. If the lines are unclear or need adjustment, 

use the "Image" menu and options such as "Threshold" or 
"Brightness/Contrast" to optimize the lines. 

2) Create a new layer. Right-click on the line drawing layer in the Layers 
panel and select "Duplicate Layer" or drag the layer to the "Create New 
Layer" button to create a copy of the line drawing. This way, coloring can 
be done without affecting the original line drawing. 

3) Lock Transparent Pixels. Click on the "Lock Transparent Pixels" 
icon (a lock and a transparent square icon) at the bottom of the Layers 
panel on the duplicated artwork layer to ensure that color is only applied 
to non-transparent areas of the line. 

4) Select the color fill tool. Choose the "Paint Bucket Tool" or 
"Gradient Tool" depending on whether you want a solid color fill or a 
gradient fill. 

5) Set the fill color options. Set the foreground color for solid fills or 
gradient color for gradient fills below the toolbar. If pattern filling is 
desired, select "pattern filling" in the options bar of the Paint Bucket Tool 
and choose a pattern. 

6) Fill in color. Click on an area inside the artwork with the Paint Bucket 
Tool or drag the mouse across an area of the artwork with the Gradient 
Tool to fill in color or gradient. 

7) Refine coloring. For more detailed coloring, use the "Brush Tool" to 
draw on the new layer. 

8) Adjust layer blending mode. To adjust the fill color and blending 
effect with the lines, try changing the fill color layer blending mode, such 
as using "Multiply" or "Color" mode. 
These steps outline the basic process of coloring the extracted artwork in 
Adobe Photoshop. Figure 5 demonstrates the image line drawing and 
coloring effect on the "Huafen Aodou (Lu & Lee, 2024; Yang, 2013)." 

 
Figure 5: Line Drawing and Coloring Effect on "Huafen Aodou" a: Peach image b: 
Rose rape and lotus flower image c: Twining flower image d: Persimmon image e: 

Pomegranate image f: Butterfly image 
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6.3. Extraction and Design of Images on the “Huafen Aodou” 
After extracting various auspicious floral images from the “Huafen 

Aodou”, the innovative design of the pattern through the composition of 
bipartite continuous pattern and quadripartite continuous pattern is a 
combination of natural elements and traditional art forms, which can create 
a variety of novel and culturally rich pattern design works. 

6.3.1 Innovative Design of Bipartite Continuous Pattern 
(1) Bone method selection: There are various forms of bone methods 

for bipartite continuous patterns, such as vertical, scattered, and ripple. 
Choose the appropriate bone method based on the characteristics of the 
extracted flower image as the foundation of the design. For instance, if the 
flower image features smooth lines and elegant forms, the corrugated bone 
method can be selected to reflect its sense of rhythm. 

(2) Unit pattern design: Utilize the extracted flower images as elements 
and design one or more unit patterns. These unit patterns can consist of 
complete flower images, or partial or abstract forms of flowers. Ensure that 
the unit pattern is simple, beautiful, and possesses a certain degree of 
recognition and uniqueness. 

(3) Continuous arrangement: According to the selected bone method, 
continuously arrange the unit pattern in the upward and downward or left 
and right directions. During the arrangement process, pay attention to the 
articulation and transition between unit patterns to ensure the coherence 
and harmony of the overall pattern. 

 
Figure 6: Design Proposal for Bipartite Continuous Pattern 

Above, a, b, c, and d represent the four schemes of bipartite continuous 
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pattern design (Fig. 6). The design concept for schemes a and b is to extract 
the colors of the artifacts, with red and green as the main colors and dark 
green as the background. The gold tracing technique is preserved, with 
yellow and light green as secondary colors. The edges are arranged in a 
regular and orderly manner with multiple monolithic patterns, while the 
main pattern resembles a vase, arranged in various ways. The background 
is lightened to create contrasting interspersed areas, and the colors and 
forms of each pattern intertwine, reflecting a classical beauty. The design 
concept for scheme c is also centered on extracting the colors of the 
artifacts, with red and green as the main colors and dark red as the 
background. The gold tracing technique is retained, with yellow as the 
secondary color. Two different patterns are used on the edges, with the 
main pattern being a butterfly pattern featuring changes in direction and 
size. The background patterns are superimposed and interspersed, with 
each pattern's color and form mirroring each other, creating a sense of 
rhythm and rhyme and a rich, varied aesthetic. Scheme d's design concept 
revolves around extracting the colors of the artifacts, with red and green as 
the main colors and dark green as the background. The gold tracing 
technique is preserved, with light green as the secondary color. The edges 
are arranged in a continuous pattern of individual flowers, while the main 
pattern consists of vine fruit, creating variations in size. The background is 
lightened, contributing to a sense of rhythm and rhyme and enhancing its 
classical beauty. 

6.3.2 Innovative Design of Quadrilateral Continuous Pattern 
(1) Selection of Composition Mode: The composition modes for the 

quadrilateral continuous pattern include scattered composition, dislocation 
composition, and overlapping composition. Based on the design 
requirements and the characteristics of the flower image, select the 
appropriate composition mode. 

(2) Expansion of Unit Patterns: Expand and deform the unit patterns in 
the bipartite continuous pattern to adapt them to the composition mode 
of the quadrilateral continuous pattern. Ensure that the expanded unit 
patterns are more adaptable to the effect of large-area spreading while 
retaining their original features. 

(3) Quadrilateral Continuous Arrangement: Arrange the unit patterns 
continuously in the four directions of up, down, left, and right, according 
to the selected composition. During the arrangement process, pay attention 
to the balance and coherence of the pattern to avoid overcrowding or 
emptiness. 



Cultura. International Journal of Philosophy of Culture and Axiology 21(5)/2024: 1-17 

 

11 

 
Figure 7: Quadrilateral Continuous Design Scheme 

The above designs labeled as a, b, c, and d represent the four schemes 

of the quadrilateral continuous pattern design (Figure 7). The design 

concept for scheme a is to extract the colors of the artifacts, with red and 

green as the main colors, dark green as the background, retaining the gold 

tracing technique, and using yellow as a secondary color. The overall 

pattern arrangement is centripetal, with diagonal corners on the edges. The 

size of the main pattern edges is staggered, and the background fades to 

create visual contrast between shades, achieving uniformity and coherence, 

and a rhythmic overall effect. Scheme b's design concept is to extract the 

colors of the artifacts, with red and green as the main colors, crimson as 

the background, retaining the gold depiction technique, and using yellow 

as a complementary color. The overall pattern arrangement is centripetal, 

with a vase-style central pattern. The lightened background enhances the 

visual contrast, adding more spatial depth and enhancing the beauty of the 

flowers. Scheme c's design concept is to extract the colors of the artifacts, 

with red-green as the main colors, reddish-brown as the background, 

retaining the gold tracing technique, and using yellow as a complementary 

color. The overall pattern is arranged in a centripetal manner, with 

butterflies of different sizes on the edge as a background, staggered in size 

and simple yet generous (Chakraborty & Biswas, 2020). The background's 

black and red shadows create visual contrast, making the main body 

prominent and colorful. Scheme d's design concept is to use red and green 

as the main colors, with light yellow as the background, giving an elegant 

and fresh feel. The gold technique is retained, with yellow and light green 



Qihong Yao & Yahui Liu / Image Extraction of National Intangible Cultural Heritage... 

12 

as secondary colors. The overall pattern arrangement is square and round, 

with the main body larger and surrounded by butterflies and flowers, 

adding visual aesthetics, regularity, and spatial depth. In addition to 

maintaining the traditional composition of bipartite and quadripartite 

continuous patterns, we can incorporate innovative elements and design 

concepts. For example, unit patterns can be simplified or deformed using 

modern design techniques and styles. Other cultural elements or symbols 

can also be introduced and combined with auspicious flower images to 

create designs with more individuality and cultural connotations. Through 

the steps outlined above, utilizing auspicious floral images extracted from 

the "Huafen Aodou", innovative designs are created through the 

composition of bipartite and quadripartite continuous patterns. These 

designs not only preserve the flavor and beauty of traditional art forms but 

also integrate modern design concepts and creative elements, resulting in 

works with high artistic value and practicality. 

7. INNOVATIVE APPLICATIONS IN 3D CLOTHING DESIGN 

Applying the designed continuous pattern to 3D clothing design requires 

the use of 3D design software, such as Zhejiang Lindi Technology Co.'s 

Style 3D software. The pattern can be applied to the garment model as a 

texture map, requiring adjustments to the size, orientation, and position of 

the pattern to ensure it matches the 3D shape of the garment. For example, 

the image extracted from the "Huafen Aodou" and designed as a bipartite 

and quadripartite continuous pattern is innovatively applied to a fishtail 

skirt suit: 

7.1. Fishtail Skirt Suit Design 

When designing a fishtail skirt suit, it's important to consider whether 

the style will utilize bipartite continuous pattern, quadripartite continuous 

pattern, individual patterns, or a comprehensive application of patterns. 

Full consideration should be given to how the patterns can be combined 

with various parts of the garment, such as the body and hemline. Some 

details may need to be adjusted multiple times to achieve the best effect in 

clothing modeling (Alraouf, 2024). 

7.2. Fishtail Skirt Suit 3D Modeling 

To begin 3D modeling of the fishtail skirt suit, open the Style 3D 

software, select the model, and import it. For this application, a 3D model 
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with a height of 178cm, waist 64cm, and shoulder width of 40cm is 

selected. After selecting the model, import the fishtail skirt suit sample in 

DXF format and modify it according to the model's size. Use the plate 

editing tool in the Style 3D software to adjust the length of the garment 

and the amount of looseness by moving the plate's edge (Figure 8). Adjust 

the skirt split line using the Edit Curve and Add Point tools. Rearrange the 

sample for the model in the 3D viewport using the Model Arrangement 

Points tool, and move the plate to the appropriate position using the 

Positioning Ball tool and the Arrangement property in the Attribute Edit 

viewport. Use the Thread Sewing and Free Sewing tools to sew the parts 

that need to be sewn in the 2D viewport. Check the sewing lines in the 3D 

viewport, and if there are any errors, use the Edit Sewing tool to make 

alignment adjustments (Vanderploeg et al., 2017). 

 
Figure 8: Open the Style 3D Software, Import the DXF Format Template, and Use 

the Editing Plate Tool to Adjust the Template. 

In the Style 3D software, utilize the Edit Plate tool to adjust the length 

and looseness of the garment by moving the net edge of the plate. Adjust 

the garment's length to 40cm, the waist to 66cm, and the skirt's length to 

76cm. Utilize the Edit Curve and Adding Points tools to make adjustments 

to the skirt segmentation line (Liu et al., 2024). Then, rearrange the pattern 

for the model in the 3D viewport using the Model Arrangement Points 

tool, and position the panels correctly using the Positioning Ball tool and 

the Arrangement Properties in the Attribute Edit viewport. Next, use the 

Thread Sewing and Free Sewing tools to sew the parts needing stitching in 

the 2D viewport, which can be synchronized with sewing line checking in 

the 3D viewport. If any errors arise, utilize the Edit Sewing tool to make 

alignment adjustments (Figure 9) (Chen, 2013). 
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Figure 9: a: Conduct Stitching Line Checks in the 3D Viewport; If There are Any 

Errors, Use the Edit Sewing Tool for Alignment Adjustments. b: Utilize the Thread 
Sewing and Free Sewing Tools in the 2D Viewport to Sew the Parts Requiring 

Stitching. 

7.3. Innovative Application of “Huafen Aodou” Pattern in Fishtail Skirt 
Suit 

Firstly, import the designed pattern into the 3D design software and 

precisely adjust the layout according to the style and structure of the 

garment. Then, select the fabric used in the garment from the fabric 

column, add the drawn bipartite continuous or quadripartite continuous 

pattern of "Huafen Aodou" to the texture in the attribute editing window, 

and complete the application of the pattern and morphological changes in 

the garment by adjusting the mapping method, editing the picture, 

changing the color, and adjusting the size and angle of the texture 

parameters. 

Next, use the Bright Line Tool and Insert Tool to add detailed designs 

to the garments, enriching the structure and color matching. In the pattern 

window, import the pattern and position it on the plate for printing with 

the pattern tool (Zhou, 2024). Adjust the size of the pattern with the Adjust 

Pattern Tool. In the attribute editing window of the pattern, adjust the 

pattern size, rotation angle, and color, and also refine the pattern process 

to create different pattern effects. Through various parameter adjustments, 

a variety of matching schemes can be realized. Utilizing the functions of 

3D design software, simulate the three-dimensional effect of the garment 

and observe the rendering effect of the pattern on the garment. Necessary 

modifications and optimizations can be made accordingly (Figure 10). 
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Figure 10: Innovative Applications of “Huafen Aodou” Pattern in Fishtail Skirt Suit 

Innovative applications in 3D clothing design can manifest in various 
ways, such as experimenting with new ideas and elements in pattern design, 
seamlessly integrating bipartite and quadripartite continuous patterns with 
other design elements, or innovating in clothing styles and structures, 
harmonizing patterns with the garment's style and structure to produce 
distinctive and creative clothing pieces (Tao, 2017). In conclusion, the 
design of bipartite and quadripartite continuous patterns, derived from the 
image extraction of Huafen Aodou, and their innovative application in 3D 
garment design, offer a fresh interpretation of the image elements found in 
Ningbo Mud-Gold Color Paint. These traditional patterns are deftly 
merged with modern aesthetics to yield a series of unique clothing designs. 
Not only do these creations showcase the distinctive charm of intangible 
cultural heritage, but they also infuse modern clothing design with new 
vitality and creativity, rendering the patterns more contemporary and 
captivating (Yen & Hsu, 2017). 

8. CONCLUSION 

To summarize, the extraction of images from the national intangible 

heritage Ningbo Mud-Gold Color Paint and their innovative application in 

3D clothing design not only represents the preservation and promotion of 

traditional culture but also signifies the expansion and deepening of 

modern design concepts. Through comprehensive research and image 

extraction of Ningbo Mud-Gold Color Paint, we not only preserve the 

unique charm of this traditional art form but also infuse it with new vitality. 

In the realm of 3D clothing design, the innovative use of Ningbo Mud-
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Gold Color Paint images not only enriches the elements and expressions 

of clothing design but also opens up new avenues and ideas for clothing 

design. This innovative application not only revitalizes Ningbo Mud-Gold 

Color Paint images in modern society but also imbues clothing design with 

greater cultural significance and artistic value. Looking ahead, we anticipate 

the continued innovative application of traditional cultural elements in 

modern design, bringing more beauty and depth to our lives. 
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